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Abstrak

Penciptaan dan madifikasi game komputer sebagai fasilitas untuk bermain
afaupun media hiburan semakin berkembang seiving dengun perkembangan teknologi
seria inovasi. Pengembangan game ini berbasis pada ketertarikan animasi penampilan
serta tingkat kesulitan yang lebih tinggi dibandingkan dengan game yang sama pada
versi faoma.

Proses pengembangan game ini dimndai davi mempelajori dan menganufisis
system permainan game Tom Adventure versi lama kemudian menyusur dan membuat
desain sistem, membuat alur permainan serta komponen — komponen lgin yang
dibutuhkan. Proses pembuatan program mengeunakan bahasa pemrograman Micrasofi
Viswal Basic 6.0,

Dengan adanya permainan game Tom Adventure ini penulis berharap bahwa
pengembangan game ini akan memberikan wacana baru tentang game dan menambah
pengetahuan penulis tentang cara mengembangkan suatu game.

Kata Kuneci : Game, Visual Basic 6.0, Tom Adventure

Abstrack

Creation and modification of computer pames as a facility for play or media
entertainment is growing in line with develupments in techmology and innovation. The
development of this game is based on atfraction animated appearance and level of
difficulty higher than the same game on the old version.

This game development process starts from studving and analyzing game
systems old version of the game Tom Adventure then compile and make the system
design, makes the play's plot and other components needed. The process of making o
pragram using Microsoft Visual Basic 6.0

With the games Tom Adventure is the author hopes that the development of this
game will give a new discourse about gaming and adds lo the mithors' knowledge on
how ta develop a game.

Keyword : Game, Visual Basic 6.0, Tom Adveniure
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BAB 1
PENDAHULUAN

Latar Belakang

Microsoft Visual Basic merupakan bahasa pemrograman yang berbasis
microsoft windows, sebagai bahasa pemrograman yang mutakhir, Microsoft Visual
Basic 6.0 didesain untuk dapat memanfaatkan fasilitas yang tersedia dalam
Microsoft windows. Microsoft Visual Basic 6.0 juga merupakan bahasa
pemrograman Object Oriented Programing (OOP), vaitu pemrograman yang
berorientasi objek.

Visual Basic merupakan salah satu soffware untuk membuat program yang
cukup sederhana tetapi banyak cakupan yang dapat dikerjakan, karena visual basic
dapar mengakses banvak software seperti Excel, Access dan sebagaiya. Visual basic
lebih sederhana dari pemrograman vang lain. Kesederhanaan visual basic terletak
pada kemudahan membuat bahasa pemrograman dan bentuk tampilan yang
dikehendaki. Visual Basic ini merupaksn pengembangan bahasa basic yang
diterapkan pada program vang berbasis Windows. Dengan menggunakan Visual
Basic maka setiap objek baik dalam bentuk gambar, movie, ataupun suara dapat
terorganisir dengan baik, dengan demikian Visual Basic dapat digunakan untuk

membuat game.

Salah satu permainan (geme) computer yang cukup menarik adalah Tom
Adventure, vaitu seorang pemburu harta karun, menemukan skip kuno yang
menunjukkan peta sembilan daerzsh dimana bertebaran pecghan berlian yang
berukuran besar, Sclain penuh dengan pecahan berlian, di sembilan daerah tersebut
juga terdapat sekelompok naga tidur yang akan menyerang tiap orang yang
mengganggunya. Lebih berbahaya lagi, di masing-masing daerah tersebut terdapat
tiga mumi yvang ditugaskan menyerang manusia yang memasuki daerah tersebu.
Game Tom Adventure versi pertama masih memiliki kekurangan dimana tingkatan
levelnya hanya lima dan tantangan di tiap levelnya masih dirasakan kurang

contohnya treasure tidak bertambah ditiap kenaikan level, mumi tetap dari level




awal hingga akhir dan rintangan naga tidak bertambah, Berdasarkan uraian diatas,
penulis bermaksud untuk mengembangkan game Tom Adventure menggunakan

Yisual Basic.

1.2 Rumusan Masalah
Berdasarkan latar belakang pemiliban judul, maka vang menjadi permasalahan
adalah bagaimana mengembangkan geme Tom Adventure dengan menggunakan
bahasa pemrograman Visual Basie.

1.3 Tujuan dan Manfaat
Tujuan penyusunan skripsi ini adalah untuk pengembangan game Tom Adventure
dengan menggunakan bahasa pemrograman Visual Basic 6.0,

Manfaat dari penyusunan skripsi ini vaitu dapat dijadikan sebapai sarana
hiburan vang cukup menarik.

1.4 Pembatasan Vasalah
Karena keterbatasan waktu dan pengetahuan penulis, maka ruang lingkup

permasalahan dalam mengembangkan game ini antara lain :

1. Input dibatasai hanva pada kevboard scdangkan ewipid perangkat lunak pada
layar monitor.

2. Jumlah pemain satu (1) orang.

3. Dalam menu utama permainan menggunakan bahasa Indonesia.

4. Level permainan sampai level sembilan (9), dan pemain hanya mendapatkan
modal 3 life.

5. Tingkat kesulitan game normal.

6. Dikembangkan menjadi 2 level.




1.6

7. Penambahan halaman setting pemain, skor tertinggi,petunjuk dan profil.

Metodologi Penyelesaian Masalah

Metode yang digunakan dalam pengembangan Game Tom Adveniure adalah :

1. Menganalisa bagaimana sebaiknya game Tom Adventure ini berjalan.

2. Mengatur gerakan mumi,

3. Mempelajari cara pembuatan game dengan Visual Basic.

4, Merancang interface untuk game Tom Adventure.

5. Mencari source code Visual Basic.

Sistematika Penulisan

Pada penulisan tugas akhir ini terdiri atas lima pembahasan vaitu :

BABI

BAB 11

BAB IIT

: PENDAHULUAN

Bab ini merupakan pendahuluan dimana akan tercakup secara
umum mengenai latar belakang penulisan laporan, ruang lingkup
karya tulis ini, tujuan dan manfaal yang mau dicapai, metodologi
vang dipakai dalam penvusunan laporan dan sistematika penulisan

wvang digunakan.

: LANDASAN TEORI

Bab ini berisi tentang teori-teori yang mendukung dan
berhubungan dengan  judul penulisan tugas akhir.

: METODOLOGI

Bab ini berisi prosedur percobaan dan menjelaskan tentang metode

penyelesaian yang dilakukan.




BAB IV

BAB Y

: IMPLEMENTASI DAN PENGUJIAN

Bab ini berisi penjelasan pembahasan program sesuai dengan

permasalahan yang diambil dalam penulisan tugas akhir.

: PENUTUP

Bab ini berisi kesimpulan dan saran dari penulisan tugas akhir.




2.1

BAB 11
LANDASAN TEORI

Sejarah Perkembangan Game

Bermain game bukanlah sesuatu vang asing, hingga kini telah banyak
mesin-mesin_ pemutar game atau consele yang mampu menampilkan game yvang
memukau, perkembangan game memang begitu pesat seiring dengan
perkembangan teknologi, inovasi tidak berhenti sampai disitu, perkembangan game

juga merambah ke komputer, berikut sejarah perkembangan game.

2.1.1 Game Generasi Pertama

Pada tahun 1952, di Universitas Cambridge Amcrika Serikat, Douglas
menulis sebuah tesis untuk gelar scbuah PhD-nya mengenai interaksi antara
computer dan manusia, dalam tesisnya itu ia menciptakan geme computer dari
sebuah permainan tradisional bernama Tic-Tac-Toe, game ini diprogram dengan
memakai computer EDVAC vacum tube yang memiliki layer berupa carhode ray
tube (CRT), kemudian ditahun 1958, William Haginbhotam menciptakan video
game pertama, berbeda dengan douglas, video game pertamanya yang berjudul
Tennis for Two diciptakan dan dimainkan di oscifloscope.

Akan tetapi game generasi pertama vyang benar-benar diciptakan
menggunakan computer adalah spacewar, dimana apda tahun 1960-an computer
adalah barang yang biasa dipakai untuk kepentingan riset dalam dunia militer, akan
tetapi sesorang bernama Steve Russel memiliki ketertarikan akan hal lain, bersama
teman-temannya Russel membuat sebuah game bemama Specewar yang
terinspirasi dari fiksi ilmiah berjudul skvlark karangan Edward E Smith, kebetulan
Steve Russel berkerja mengpgunakan sebush computer mainframe bernama MIT
PDP-1 vang biasa dipakai untuk perhitungan statistic, dengan computer itulah dia
membuat Spacewar ditahun 1961.




2.1.2 Game Generasi Kedua

Di tahun 1971, Nolan Bushnell bersama 1ed Dabney menciptakan game
ber-genre arcade yang bermmama Space, game tersebut didasanri oleh Spacewar,
tahun (972 Nolan dan Ted mulai membuat Atari computer, kemudian dia
mengembangkan game berjudul Pomg vaitu game pertama yang tersedia uniuk
public, karena game-game sebelumnya hanya ada dalam computer mainframe untuk
kesenangan sendiri saja, asal usul Pong dimulai saat Nolan ingin membuat game
sedethana dan mudah dimengerti, dengan memeory dan microe processor kelas
rendah, kemampuan proscs yang terbatas dan grafis sederhana, akhimya dia
membuat versi elektronik dari permainan Ping Pong yang kemudian menjadi Porg.

Sedikit selingan, Pong kemudian berevolusi menjadi sebuah game bernama
Breakout, game tersebut diciptakan oleh Steve Jobs untuk Atani, dari situ Steve jobs
dan temannya Steve Wozniak mulal berpikir untuk menciptakan sebuah PC,
kemudian mereka meminjam semua peralatan yang dipakai dalam proyek Breakou
dan membuat Profotype bernama Apple 1 yang merupakan cikal bakal dan
computer Apple Macintosh vang ada sekarang.

Pada tahun 1980, Atari mengeluarkan game berjudul Asteroid dan Lumnar
Lander, kedua game terscbut adalah game pertama yang didafiarkan pada kantor
hak cipta untuk mendapat hak paten, Asteroid merupakan game yang penuh inovasi
baru dalam grafisnva, dari pada menggunakan metode raster, game ini merupakan
grafis vecior line seperti yang ada pada oscilloscope.

Pengenalan Atari Video Computer System (Atarl 2600} dengan CPU hiasa
dan slot untuk kasetnya menjadi era baru dalam dunia game, ditahun 1980 juga
menunjukan penjualan yang meningkat dari PC yang biasa dipakail untuk game,
hingga kini computer bersaing dengan mesin konsol seperti PS dan XBOX, dan
computer tidak hanya sebagai mesin untuk kepentingan bisnis semata, tapi juga
untuk hiburan seperti game.




2.2 Jenis Game

Saat ini banyak ditemukan game, baik itu game PC, game consele (scperti
PS, XBOX, PSP, Nintendo DS), game HP (mobile game) dan game flash, dari
banyaknya pame vang ada, berdasarkan game pfay (cara memainkannysa), game
dapat diklasifikasikan menjadi beberapa jenis, diantaranya :
221 Board Game
Board Game atau dapat diistilahkan sebagai “permainan papan™, pada jenis
game ini, pemain diberikan sebuah tampilan vang berisi lentang masalah untuk
diseclesaikan, contoh dari game ini antara lain Pipe Dream, Hangaroo, Rotation,
Ballflect, Catur, Permainan kartu dan sebagainya.
2.2.2, Arcade
Game bertipe arcade merupakan game yang menguji kecepatan tangan dari
pemainnya, pada permainan bertipe arcade, semakin tinggi level permainan maka
permainan akan semakin cepat, contoh adari game bertipe arcade adalah Feeding
Frenzy, Pacman, Arcanoid, Pong, Baba Ball dan sebagainya.
223 Action
Berbeda dengan game bertipe arcade, game tipe action menjadikan pemain
mengendalikan karakier utama dalam game tersebut melakukan kegiatan (action)
seperti melompat, menembak dan sebagainya. Contoh dari game bertipe action
antara lain adalah Super Mario, Mocil, Petualangan Paddle Pop, Alloy Tease Exile
dan sebagainya.
224 Shooting
Game bertipe shooting sebagian besar menggunakan mouse sebagai alat
pengendalinya pada pame ini pemain seolah-olah berperan sebagai penembak (first
person) atau pemain mengendalikan seorang penembak (third person), contoh game
bertipe shooting antara lain Duck |lunt, Counter Strike, Onumusha dan scbagainya.
2.2.5 Fighting
Game bertipe fighting pada dasarnya sama dengan game action. hanya saja
bertipe fighting pemain mengendalikan scbuah karakter untuk berkelahi dengan




karakter lain sampai salah satu karakter kalah, conoh dari game bertipe fighting

antara lain Street Fighter, Tekken. Duel, Roman vs Samurai dan sebagainya.

126 Racing
Game bertipe racing pada dasarnya adlaah scbuah permainan mengeerakan
kamera, pemain diberikan sebuah kendaraan atau sejenisnya untuk menempuh rute
tertentu, contoh dari game bertipe racing antara lain Need For Speed, Auto bahn
dan sebagainya.
2.27 Simulation
Game bertipe simulasi adalah game yang mensimulasikan suatu kegiatan
yang sesungguhnva, contoh dari game tersebut antara lain Tycoon, Simulator
Pesawal, Burger Empire dan sebagainya.
228 Real Time Strategi
Game bertipe RTS memposisikan pemain sebagai seorang pemimpin yang
mengatur sesuatu (bisa berupa pasukan, koloni, kerajaan dan lainnya), contoh dari
game bertipe RTS anatara lain War Commander, Empire Earth, Stronghold dan
schagainya.
2.2.9 Role Playing Game
Pada game bertipe RPG pemain memerankan sebuah karakter dalam game,
Berbeda dengan game bertipe action, pada game RPG hal yang divtamakan adalah
cerita dalam game, selain itu dalam game bertipe RPG biasanva terdapat sub game
dengan tipe lain (seperti bertipe fighting, action atau RTS), contoh game bertipe
RPG antara lain BOBO games, Zelda, Megaman, Smarty dan sebagainya.
2.2.10 Masive Multiplayer Online
MMO  (Masive Multiplayer Online), merupakan game yang dapat
dimainkan sccara bersama-sama pada imrernet browser, hal yang diutamakan dalam
sebuah game bertipe MMO adalah kebersamaan dengan pemain lai, contoh dari
game bertipe MMO antara lain Ragnarok, Pangya, Gun Bound dan Seal. Game
flash bertipe MMO masih sangat scdikit, hal tersebut dikarenakan untuk membuat
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game flash MMO diperlukan software lain (server side software) seperti PHP, CGI,

Fire Fox dan sebagainya.

Karakter Dalam Game

Salah satu elemen terpenting dalam gome adalah karakter, karakier dalam
game memiliki pengaruh vang sangat kuat terhadap game, dimana dengan karakier
tersebut sebuah game dapat menjadi terkenal atau tidak. Contoh karakter yang
menjadikan suatu game terkenal antara lain Super Mario pada semua seri yame

‘Super Mario, Sonic, Ray-man, dan beberapa karakter pada game RPG terkenal

seperti Final Fantasy, Shining Force dan sebagainya.

Untuk membuat karakter vang menarik perlu mengetahui seni menggambar, baik
itu menggambar secara manual maupun menggambar secara digital. Pada dasamya
keduan cara tersebut sama hanva saja media vang digunakan berbeda serta
pengetahuan terhadap suatu daya desain. Berikut pembagian karakter berdasarkan

gava desain:

2.3.1  Gaya Realis Detail

Gaya ini biasanya ditangani oleh orang professional yang telah mahir mengolah
gambar, selain itu untuk menangani gaya realis yang detail. Flash mengalami
kesulitan kareria flash tidak memberikan efek shading (bayangan) dan lighting
{pencahayaan), meskipun dalam (ash 8 terdapat efek blur dan shadow, tetapi efek
tersebut tidak optimal untuk membuat gaya realis dan detail, sehingga dibutuhkan

software lain semacam Adobe Photoshep, Firework, Gimp atau sejenisnya.

2.3.2 Gaya Realis Sederhana

Gaya ini merupakan penyederhanaan dari gaya realis detail. Untuk membuatnya
dapat dilakukan proses fracing atau menjiplak sebuah gambar realis dan
mengurangi detailnva. Dalam game flash, gaya [ni lebih banyak dipakai, karena
selain lebih mudah membuatnya, karakter yang tidak terlalu detail membuat movie

berjalan normal,
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233 Gaya Kartun
Gaya imi merupakan penyederhanaan dan perubahan bentuk dari gaya realis
sederhana. Gaya kartun tetap mempertahankan svatu bentuk standar. Sebagai
contoh manusia memiliki kepala, badan, tangan dan kaki. Bentuk tersebut tetap
dipertahankan namun dengan proporsi dan penggavaan yang berbeda.

2,34 Gaya Imajinasi
Gaya ini bersifat bebas, tidak terikat dengan bentuk realis dan merupakan hasil
dari imajinasi pencipta game. Beberapa game tlash menggunakan karakter bergaya
imajinasi karena selain mudah membuatnya, karakter bergaya imajinasi juga dapat

mempermudah dalam membentuk sebuah image (trademark) kepada publik.

24  Background Game
Selain karakler, dalam game juga dibutuhkan sebuah background atau latar
belakang. Membuat background dalam flash dapat dilakukan dengan beberapa cara
seperti pada pecmbuatan karakter. Berikut jenis-jenis background dalam game flash,
2.4.1 Static Backgronnd
Static Background atau background diam sering digunakan pada game flash.
Selain mudah membuatnya, static backeround tidak membutuhkan scripr khusus
untuk menggerakannya. Perhatikan contoh dari game yang menggunakan static
background berikut.
2.4.2 Scrolling Background
Berbeda dengan static background yang diam, background bertipe scrolling
bergerak dari kanan ke kiri, atas kebawah atau sebaliknya. Tingkat kesulitan dari
pembuatan scroifing background adalah pengolahan script, karena tanpa script yang
baik, movie tidak dapat berjalan sesuai yang diharapkan. Perhatikan contoh dan
game yang menggunakan scrolling background berikut.
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243 Paralax Background

Parglax background adalah background berlapis, dimana background yang
lebih dekatl dengan mata pemain, bergerak lebih cepat dari background yang jaub
dari mata pemain. Selain menambah kesan kedalaman, penambahan paralax
background dapat menambah kesan realis suatu game. Untuk membuat paralax
background pada game harus membuat minimal dua lapis backeround dengan
kecepatan yang berbeda, perhatikan gambar berikut.

2.4.4 Random Background

2.5

Pada dasamya random background sama seperti background scrolling,
hanya saja random background berjalan secara acak, baik itw dari sisi kanan ke kiri,
atas kebawah ataupun scbaliknya.

Animasi

Animasi merupakan salah satm bagian grafika komputer vang menyajikan
tampilan-tampilan yang sangat atraktif juga merupakan sekumpulan gambar yang
ditampilkan secara berurutan dengan cepat unluk mensimulasi gerakan yang hidup.
Pemanfaatan animasi dapat ditujukan untuk simulasi, menarik perhatian pemakai
komputer pada bagian tertentu dari lavar, memvisualisasikan cara kerja suatu alat
atau menampilkan keluaran program dengan gambar-gambar yang menarik
dibandingkan dengan sederetan angka, serta tidak ketinggalan untuk program-
program permainan.

Pada dasarnva, animasi adalah transformasi objek dimana semua titik pada
sembarang objek akan diubah sesuai dengan aturan tertentu, sementara sistem
koordinatnya tetap, Implementasi pada animasi dapat dikerjakan secara interaktif
maupun non interaktif. Dibandingkan animasi non interaktil, animasi interaktil
memberikan tampilan yang lebih menarik dan dinamis. Pada animasi interaktif,
pergerakan objek mengikuti perintah yang diberikan oleh pemakai lewat perangkat
interaktif, sedangkan animasi nom interaktif, pergerakan objek hanya dikendalikan
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dari prosedur yang ada di dalam program-program permainan, sedangkan animasi
non inreraktif kebanyakan untuk melakukan simulasi objek.

Pembuatan aniamsi masih dilakukan secara sederhana dan konvensicnal dengan
cara menggerakkan beberapa gambar secara bergantian dan cepat sebelum tahun
1970-an. Gambar terscbut masih menggunakan lukisan tangan atau menggunakan
foto dari serangkaian kejadian, hingga pada akhir tahun 1970-an, seorang ahli
program bernama Julian Gomez mengembangkan sebuah program khusus untuk
animasi, Pengembangan program tersebut dilakukan di Negara bagian Ohio,
Amerika Serikat.

Komputer digital vang berkembang pesat sangat mempengaruhi proses pengerjaan
animasi, Animasi kemudian membentuk suatu bidang baru dalm ilmu computer
yaitu grafika computer yang dapat digunakan untuk menggambarkan cara kerja
suatu alat dan menampilkan keluaran program berupa gambar yang lebih hidup dan
interaktif,. Animasi banyak digunakan pada berbagai bidang seperti bidang
perekayasaan, arsitekiur. ekonomi, kedokteran dan lain-lain.

Animasi yang bagus dihasilkan dari gambar yang cukup banyak agar gambar yang
dihasilkan akan tampak gcrakan yang berkesan halus. Gambar-gambar terscbut
haruslah berpindah posisi sekecil mungkin agar pada perubahan atau pergantian
gambar terlihat lebih menarik dan bagus. Selain itu dieperlukan juga kecepatan
tertentu untuk tampilan gambar vang akan dibuat dalam animasi. Hal ini tergantung
pada jumlah gambar yang diberikan, kecepatan yang dimaksud yaitu begitu suatu
gambar ditampilkan, maka akan berganti gambar berikutnya dengan kecepatan
tertentu, makin cepal pergantian antara satu gambar dengan gambar berikutnya
maka akan menghasilkan gerakan gambar vang semakin halus,

Ada empat dalam flash untuk membuat animasi, yaitu animasi frame by frame,
animasi mofion tween, animasi shape heeen dan animasi motion guide. Dimana
keempat cara tersebut secara konsep yang sama dan digunakan dalam animasi yang
berbeda.




2.6

13

Format Citra

Dalam sistem operasi Windows, mendukung beberapa jenis format gambar.
Aplikasi pengolahan grafis juga menyediakan fasilitas untuk membuka file — file
dengan format yang berbeda. Adapun beberapa jenis format gambar yang didukung
oleh sistem operasi Windows dan aplikasi grafis seperti : JPEG, WMF, BMP dan
GIF,

2.6.1 Format Citra JPEG

IPEG ( Joint Photographic Experts Group) adalah teknik kompresi grafik
high color bitr — mapped dan juga standar fife vang dikembangkan oleh grup joins
photographic experts yang mengpunakan kombinasi DCT  (fMserete Cosine
Transform) dan pengkodean huffman untuk mengkompresi suatu file citra.

JPEG adalah suatu algoritma kompresi yang bersifat /ossy dimana kualitas
citranya kurang bagus. Lossy compression adalah metode memperkecil ukuran file
¢itra dengan cara membuang beberapa data, hal ini menyebabkan adanva sedikit
penurunan kualitas citra. JPEG merupakan teknik dan standar universal umtuk
kompresi dan dekompresi citra tidak bergerak untuk digunakan pada kamera digital
dan sistcm pencitraan menggunakan komputer yang dikembangkan oleh Joint

Pphotographic experis group.

2.6.2 Format Citra WMF

WMF ( Windows Meta File) adalah suam format fife grafik standar
Windows yang biasanya digunakan pads clipboard dan representasi sebuah grafik .
Format #ile ini menyvimpan semua komponen dari suaw grafik beserta dengan
atribut — atributnya seperti garis (fines), warna (colors), pola (potterns), teks (fext)
dan atribut teks (text atfribufes). Adapun jenis format file WMF yang telah
ditingkatkan dari segi kualitas grafiknya vaitu EMF { Enchange Metu File).
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2.6.3 Format Citra BMP

Format file BMP merupakan format file gambar standar untuk komputer —
komputer yang menjalankan sistem operasi Windows. Format file ini
dikembangkan oleh pihak Microsoft untuk menvimpan file pambar (bifmap) dan
memungkinkan Windows untuk menampilkan kembali gambar tersebut, Struktur
dari file BMP terdiri dari Birmapfileheader dan Birmapinfoheader. Struktur
Bitmapfileheader menyimpan informasi mengenai dimensi dan format warna dari
device independent bitmap (DIV).

Jadi dapat disimpulkan bahwa Bitmapfileheader memberi informasi
mengenai file dan Bitmapinfoheader memberikan informasi mengenai gambar.
Tabel wamna yang didefinisikan schagai array dan struktur RGBQUAD dan sizanya
adalah data gambar. Format ini mendukung resolusi dan monokrom hingga frue

color (16,7 juta warna).

2.6.4 Format Citra GIF
GIF (Graphics Interchange Format) merupakan formal gambar standar
yang menyediakan sejumiah kemampuan seperti ketajaman gambar (sharp) resolusi
gambar (resolufion) vang baik serta ukuran file gambar yang relatif lebih kecil.
Bagus tidaknya resolusi gambar GIF yang dihasilkan juga tergantung pada
perangkat keras (Graphics Hardware) vang digunakan. Perangkat keras tersebut
harus dapat menghasilkan resolusi wamna gambar yang tajam dengan pixel wama

yang baik.

FPixel merupakan elemen yang terkecil dalam sebuah pambar. Pixel
berhubungan dengan titik (dof) dalam layar grafik. Misalnya sebuah gambar
memiliki ukuran sebesar 320 x 320. Hal ini mempunyai arti bahwa gambar tersebut
mempunyai jumlah pixe! sebanyak 320 x 320. Semakin banyak pixe! vang terdapat
dalam objek gambar, maka semakin halus gambar tersebut karena jarak antar pixe/
semakin rapat dan semakin besar ukuran fife tersebut, Begitu juga sebaliknya,
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dimana semakin sedikit jumlah pixef yang terdapat pada objek gambar, maka
tampilan gambar tersebut terlihat kasar karena jarak antar pixe! renggang dan
ukuran file yang dihasilkan lebih kecil.

Format GIF ditujukan untuk mendukung format gambar saat ini dan format
gambar yang akan datang. Format GIF mempunyai ckstensi .gif vang didukung
oleh aplikasi grafis, misalnva Microsof Paint, Corel Draw, Coref PhoroPainr,
Adobe PageMaker dan sebagainya.

2.7 Microsoft Access

Microsoft Access 2003 adalah sebush program aplikasi basis data komputer

relasional yang ditujukan untuk kalangan rumahan dan perusahaan kecil hingga

menengah. Aplikasi ini merupakan anggota dari beberapa aplikasi Microsoft Office,

selain tentunya Microsoft Word, Microsoft Excel. dan Microsoft PowerPoint,

Aplikasi ini menggunakan mesin basis data Microsoft Jet Database Engine, dan
juga menggunakan tampilan grafis yang intuitif sehingga memudahkan pengguna.
Yersi terakhir adalah Microsoft Office Access 2007 yang termasuk ke dalam

Microsoft Office System 2007.

Microsofi Access dapat menggunakan data yang disimpan di dalam format
Microsoft Access, Microsoft Jet Database Engine, Microsoft SOL Server, Oracle
Database, atau semua kontainer basis data yang mendukung standar ODBC. Para

pengguna atau programmer yang mahir dapat menggunakannya untuk
mengembangkan perangkai lunak aplikasi vang kompleks, sementara para
programmer yang kurang mahir dapat menggunakannya untuk mengembangkan
perangkat lunak aplikasi yang scderhana. Access juga mendukung teknik-teknik
pemrograman betorientasi objek.

2.8 Microsoft Visual Basic 6.0

Visual Basic (sering disingkat sebagai VB saja) adalah merupakan sebuah
bahasa pemrograman yang menawarkan [aiegrated Development Environment (IDE)
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visual untuk membuat program perangkat lunak berbasis sistem operasi Microsoft

Windows dengan menggunakan mode] pemrograman (COM). Dengan menggunakan
Visual Basic maka setiap objek baik dalam bentuk gambar, movie, ataupun suara
dapat terorganisir dengan baik, dengan demikian Visual Basic dapat digunakan

untuk membuat game.

Microsoft Visual Basic 6.0 merupakan bshasa pemrograman yang cukup
populer dan mudah untuk di pelajari. Visual Basic digunakan untuk membuat
program dengan aplikasi GLI (Graphical User Interface) atau program vang
memungkinkan pemakai komputer berkomunikasi dengan komputer tersebut dengan

menggunakan modus grafik atau gambar.

Microsoft Visual Basic menyediakan fasilitas yang memungkinkan untuk

menyusun sebuah program dengan memasang objek — objek grafis dalam sebuah
form.

Microsoft Visual Basic 6.0 berawal dari bahasa pemrograman BASIC
{Beginners All-purpose Symbolic Instruction Code). Karena bahasa BASIC cukup
mudah untuk dipelajari dan populer, maka hampir setiap programmer menguasai
bahasa ini.

Tahun 1980-an sistem operasi DOS cukup populer di kalangan pemakai PC
karena di dalamnya disertakan bahasa QBASIC (Quick Basic). Sistem tersebut
sekarang sudah jarang di gunakan. Di era Windows, Microsoft menciptakan Visual

Basic yang terus mengalami penyempurnaan hingga Visuval basic 6.0 ini.
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PEMBAHASAN DAN PERANCANGAN

Pembahasan

Proses perancangan permainan pame Tom Adventure melalui beberapa tahapan

proses sebagai berikut;
3.1.1

3.1.2.

Perancangan Karakter

Karakter yang ada dalam game ini

a. Jfom
b. Mumi
c. Putri

Ketiga karakter tersebut memiliki tugas vang berbeda-beda Tom akan menjadi
petnalang vang bertualang mengumpulkan harta pada tiap levelnya, Mumi akan
menghalangi tom uniuk mengumpulkan harta dengan cara mengejarnya bila tom
tertangkap maka lifenya akan berkurang, dan putri akan muncul setelah tom
berhasil mengambil semua bunga vang ada pada tiap levelnya dan lifenya akan
bertambah satu |

Perancangan Animasi dan Suara.

CGiambar Tom, Muwmi dan Puitrf berhasil dicari pada sumber-sumber di internet,
kemudian di-edif dan disimpan dengan menggunakan aplikasi Adobe
Phatoshop, fek animasi yang digunakan merupakan proses pergantian gambar,
Sedangkan backsound dirancang dengan menggunakan aplikasi Recorder.

Membuat Mask dengan Adobe Photoshop
Ada Banyak program desain gratis yang dapat digunakan untuk membuat sprite dan

mask yang akan saya gunakan dalam pembuatan program permainan. Salah satunya

adlash Adobe Photoshop, yvang dapat digunakan untuk membuat sprite sekaligus

mask dengan mudah,

Bukalah file baru melalui menu File > New. Tentukan ukuran gambarnya.

17
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2. Buatlah warna latar belakang menjadi hitam dengan Edit = Fill dengan
Content = Use : Black

3. Kita dapst menggambar sprite diatas latar belakang hitam dengan pencil tool,
Brush tool, dan sebagainya.

Tl W A GhE pRE e e e S
I e TR E - " I_‘I|ﬁ‘lm;k

Gambar 3.1 Menggambar Sprite

4. Jika sudah selesai, tekan D untuk mengubah wama yang akan digunakan
menjadi hitam-putih, Seleksi gpambar dengan menekan Ctrl + A, atau menu
Select > All. Kemudian, copy gambar ke clipboard dengan menekan CTRL +
C. atau menu Edit > Copy.

5. Selanjutnya Kita perlu melebarkan kanvas melalui menu Image = Canvas Size.
Kita dapat menempatkan mask di sisi manapun. Misalnya, kita akan
menempatkan mask di sisi bawah, maka tinggi gambar harus diperbesar dua kali
ke bawah, Dalam contoh gambar dibawah ini tingginya adalah 110 pixel, maka
kanvas akan diperbesar menjadi 220 pixel ke bawah. Perhatikan anchor-nya,
karena panah adalam kotak anchor tersebur akan mengatur arah perbesaran.

6. Paste gambar di clipboard ke sisi samping, sehingga kita akan memperoleh dua

layer.
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Ciambar 3.2 Paste Gambar Clipboard

. Pilih Magic Wand Tool, dan atur nilai Tolerance-nya. Nilai tolerance ini akan
menentukan seberapa “peka” magic wand membedakan intensitas warna. Klik

bagian hitam (sisi luar) dari gambar.
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Gambar 3.3 Teknik Magic Wand Tool
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8. Tekan X untuk menukar wamna foreground dan background yang akan
digunakan. Kemudian tekan Alt + BaekSpace atau menu Edit = Fill, content

use : Foreground Color.

9. Pilihan kemudian dibalik dengan menekan Ctrl + Shift + I, atau menu Select >
Inverse. Mungkin kita perlu menghilangkan pilihan di sisi atas vang terjadi.
Untuk itu tahan AM, kemudian klik bagian yang ingin dihilangkan dengan
magic wand. Setelah garis pilihan hanya mengelilingi sprite, tekan D untuk
menjadikan warna hitam sebagai foreground color dan tekan Alt + Backspace,
atau menu Edit > Fill. Anda akan memperoleh Mask dibawah gambar sprite.
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Gambar 3.4 Setelah di Masking
10. Simpanlah gambar tersebut dengan memilih menu File > Save Optimized As.
Format GIF sangat baik untuk gambar — gambar kartun yang variasi wamanya
ridak kompleks. sedangkan Format JPG baik untuk menyimpan gambar dengan
variasi warna seperti foto. Visual Basic versi 6 memilki kemampuan dalam

membaca file gambar yang dikompres dalam format GIF maupun JPG.
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Aturan Permainan

Sistem permainan Tom Adventure. pemain akan berperan scbagai tom dan dapat
menggerakkannya dengan tombol panah. Tugas pemain adalah mengumpulkan
semua berlian secara hati-hati agar tidak menyentuh naga, dan lari menghindari
kejaran mumi. Setelah semua berlian terkumpul, maka akan muncul tangga ke
daerah lain dan pemain harus menuju tangga tersebut. Jika pemain lertangkap oleh
mumi, atau menyentuh naga, maka life pemain akan dikurangi satu, Pemain hanva
diberi modal tiga life. Life hanya dapat bertambah saat pemain menemukan putri
vang muncul jika pemain mengambil semua bunga. Untuk menyelesaikan

permainan ini, pernain harus dapat mengumpulkan semua berlian di semua daerzh.
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Desain Sistem
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Secara garis besar desain sistem game l'om Adventure memiliki gambaran seperti

dibawah im:
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Gambar 3.5 Desain Sistemn Game Tom Adveniure
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3.5 Flowchart

Berikut alur permainan game Tom Adventure:
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3.6 Perancangan

Perangkat lunak permainan Tom Adventure ini dirancang dengan menggunakan

bahasza pemrograman Microsoft Visual Basic 6.0. Komponen- komponen vang digunakan

dalam pembuatan perangkat lunak ini scbagai berikut :

1.

Form : merupakan lembaran kerja tempat meletakkan item dalam Window
Fisual Basic.

Label : unit ini digunakan untuk menampilkan teks, angka, atau simbol pada
saat program dijalankan.

Text Box @ unit ini digunakan untuk menampilkan teks pada form atau untuk
menerima irput dari pemakai pada saat program Fiswal Basic dijalankan.
Command Button : unit ini digunakan untuk memberikan suatu perintah atau
tindakan ketika digunakan.

Check Box : unit ini digunakan untuk memilih satu atau beberapa syarat sccara
bersamaan.

Combo Box : unit digunakan untuk memilih item lewat Drop-Down List.

7. Lime : unit ini memungkinkan pemakai membuat garis lurus.

10.

11

12.

13.
14,

Picture Box : unit ini untuk menampilkan file gambar (Bitmaps, lcon, Gif, JPG
dan sebagainya).

fmage Box : unil akan menampilkan gambar Bitmaps, Windows, Metafile dan
feon.

fimer : unit ini digunakan untuk mengoperasikan waktu kejadian pada rutin
program termasuk internal waktu.

Shape @ Unit ini membentuk objek dua dimensi (bujur sangkar, lingkaran,
emapat persegi panjang dan elips).

Progress Bar : unit ini untuk mcnampilkan berapa lama suatu operasi
berlangsung.

Menu Editor : unit ini digunakan untuk membuat menu aplikasi.

MSFlexCrid : unit ini digunakan untuk menampilkan informasi database.




Perangkat lunak ini memiliki beberapa_form vaitu :
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Gambar 3.11 Rancangan Form menu




Keterangan :
1 nama pemain
: gambar logo dari perangkat lunak.

: Commandbutton : tombol *Mulat’ untuk memulai permainan.

: Commandbutton : tembol “Petunjuk’ untuk menampilkan form petunjuk,

2
3
4 : Commandbutton : tombol “Skor Tertinggi” untuk menampilkan form skor tertinggi.
5
6 : Commandbutton :tombeol ‘Profil” untuk menampilkan form Credit.

7

: Commandbutton :tombol “Keluar” untuk keluar dari program.

3.6.2. Form Petunjuk
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Gambar 3.12 Rancangan Form Petunjuk

Keterangan :
| :petunjuk permainan.
2 : Commandbutton - tombol ‘Kembali' untuk kemhbali ke form menu utama.
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3.6.3. Form Profil
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Gambar 3.13 Rancangan Form Profil.

Keterangan :
1 :info pembuat .

2 : Commandbutton - tombol ‘Kembali’ untuk kembali ke form menu utama.
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3.6.4. Form Play
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Gambar 3.14 Rancangan Form frmPlay

Keterangan @
: Picture: Area permainan
: Text box: tampilan level
: Text box: tampilan tom life

1

2

3

4 : Text box: tampilan score

5 : Text box: tampilan jumlah treasure
6 : Text box: tampilan jumlah flower
7 : Tombol Exit

8

: Commandbutton : tombol ‘Pause’




3.6.5. Form Hi Score
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Gambar 3.15 Rancangan Form Hi Score

Keterangan :
1 : Label, keterangan untuk ITi Score
2 :Dara grid untuk tampilan tabel skor tertnggi.
3 : Commandbutton : tombol ‘Kembali” untuk kembali ke form menu utama.
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3.6.6. Form Setting Pemain
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Gambar 3.16 Rancangan Form Setting Pemain
Keterangan :
| :DatalList, keterangan untuk Hi Score
: Commandbutton: Tombol baru

: Commandbutton:Tombol hapus
: Commandbutton; Tombal aktifkan
- Commandbutton:Tombol batal
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Gambar 3.17 Rancangan Form Input Pemain

Keterangan :
| :Label: keterangan masukkan nama

2 : Textbox: masukkan nama

3 : Commandbutton:Tombol aktifkan
4 :Commandbution:Tombeol batal

Microsoft Access 2007

Microsoft Access dapat menggunakan data yang disimpan di dalam format
Microsoft Access, Microsoft Jet Database Engine, Microsoft SQL Server, Oracle
Database, atau semua kontainer hasis data yang mendukunyg standar ODBC. Para
pengguna/programmer yang mahir dapat menggunakannya untuk mengembangkan
perangkat lunak aplikasi yang kompleks, sementara para programmer yang kurang
mahir dapat menggunakannya untuk mengembangkan perangkat lunak aplikasi
yang sederhana. Access juga mendukung teknik-teknik pemrograman berorientasi
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objek, tetapi tidak dapat digolongkan ke dalam perangkat bantu pemrograman
berorientasi objek.

Dalam game ini, tidzk terdapat tampilan halaman home database akan tetapi
terdapat dua {2) databasc yaitu databasc pemain dan database skor tertinggi.

Relasi antar tabel pada database pemain Game Tom Adventire digambarkan
dalam bentuk konsep atau Conceptual Data Mode! (CDM) dan dalam bentuk fisik
atau Phyvsical Data Mode! (PDM), seperti yang ditunjukkan pada gambar berikut :

Pemain | SCORE
Naima IDSCCRE
LevelGame el LevelGame
Soore HISCCORE

Gambar 3,18 CDM Data Pemain

PEMAN SCORE
: m" IDSCORE int
MLE".I'ﬂIIIIIIIIEJI';LEJIM‘.IE rdu{ﬂ N RARAE, = AN, bl crar(2)
| scoRE int LEVELGAME fn-cra{:ey
HISCORE int

Gambar 3.19 PDM Data Pemain




BAB IV
IMPLEMENTASI DAN PENGUJIAN PROGRAM

4.1 Implementasi

Tahap implementasi pengembangan perangkat lunak merupakan proses pengubahan
spesifikasi sistem menjadi sistem yang dapat dijalankmn, tahapan ini merupakan lanjutan
dari proses perancangan, vaitu proses pemrograman perangkat lunak sesuvai dengan
spesifikasi dan disain sistem.

Dalam aplikasi pembuatan Game Tom Adventure ini, program vang digunakan
dalam pengiplementasian adalah Microsoft Visual Basic 6.0

Hasil implementasi dari Game Tom Adwventure meliputi Menu utama, Seting

Pemain, Mulai, Skor Tertinggi, Petunjuk, Profil, Keluar, dan Permainan Berjalan,

4.1.1 Spesifikasi Perangkat Keras dan Perangkat Lunak
Program ini dijalankan dengan menggunakan perangkat keras (hardware) yang
direkomendasikan minimal sebagai berikut :
I. Proxsesor Intel Pentium IV 1.5 GHz.
2. Ram 236 MB.
3. Harddisk 40 GB, dengan freespace 10 MB.
4, All VGA supported
5. Monitor dengan resolusi 800 X 600 pixef.
6. Keyboard
Adapun perangkat lunak (seftware) yang direkomendasikan untuk menjalankan
aplikasi ini adalah Microsoft Visual Basic 6.0 dan Microsoft Access 2007 sebagai
databasenya.
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4.2 Pengujian Program

Dalam pengujian program pengembangan Tom Adventure ini dilakukan beberapa
pengujian terhadap tampilan dalam game ini.

4.2.1  Pengujian Menu Utama

Klik pada file Tom Adventure.exe ataupun icon bertanda !_ . Setelah itu akan
muncul tampilan Menu Utama Game Tom Adventure

Gambar 4.1 Tampilan Menu Utama Game Tom Adventure

Sebelum memulai permainan klik setting pemain , Setelah itu akan muncul
Tampilan pilihan pemain, anda dapat mengaktifkan salah satu nama pemain yang telah
tersimpan, Apabila anda pertama kali memulai permainan maka perlu memasukkan nama
anda, setelah itu aktifkan. Untuk memulai permainan klik tombol Mulai, Setelah itu akan
D T T —
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4.2.2  Pengujian Setting Pemazin

Gambar 4.2 Tampilan Setting Pemain

Di pilihan setting pemain kita dapat memilih salah satu nama yang telah tersimpan

untuk memulai permainan atan membuat nama baru.

Gambar 4.3 Tampilan Setting Pemain Untuk Menginput Nama
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‘Gambar 4.4 Tampilan seiting pemain fom Adventure dengan nama Lolo

pemain akan mulai mengumpulkan treasure untuk melanjutkan ke level seterusnya sesuai
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4.2.3 Peogujian Permaioan Level 1

Gambar 4.5 Tampilan Level 1 Game Tom Adventure

Apabila pemain berhasil menghindari kejaran mumi dan mengumpulkan sernua
flower vang bejumlah 10 di level pertama maka akan muncul putri yang dapat diambil
untuk menambah life.
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1]

i
¥

e

Gambar 4.6 Tampilan Level | Serelah Mengumpulkan Sem

wa Flower

Apabila pemain telah mengumpulkan semua treasure maka akan muncul sebuah
tangga untuk menuju ke level selanjutnya dan begitu selanjutnva sampai level terakhir.
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CGambar 4.7 Tampilan Level | Setelah Pemain mengumpulkan semua Treasure
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Setiap kenaikan | level makan Treasure yang akan dikumpulkan selalu bertambah
begitu juga dengan naga. Mumi akan bertambah setiap 2 level,

4.2.4 Pengujian Tampilan Level

Gambar 4.8 Tampilan Level 2

Pada level 2 jumlah treasure dan flower bertambah untuk menambah tingkat kesulitan.




14

w0 AR LT
. R TR R R
IR TR -
R A ™ =
> '+ *' E *' 'f '—rﬂ_
¢ ox
¥ T Vet Y 08
+ o t + 3
A b w
: * +
v+‘ : L 'l ol . .
'-‘-' » # # # » F + ..‘.
E*-'i‘*‘r ] F ] -': . ' ‘
¢ sx ¥t L EF ¥

Gambar 4.9 Tampilan Level 3

Pada level 3 jumlah mumi vang mengejar bertambah 1 menjadi 4.

Gambar 4.10 Tampilan Level 4

Pada level 4 jumlah treasure dan flower yang harus dikumpulkan bertambah dibanding
level sebelumnya.
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Gambar 4.1 | Tampilan Level 5

Pada kenaikan setiap 2 level maka mumi bertambah | jadi pada level 5 terdapat 5 mumi
serta jumlah treasure,naga bertambah.

[T

|~

A

Gambar 4.12 Tampilan Level 6
Pada level 6 jumlah mumi sama pada level 5 tetapi jumlah treasure ,flower dan naga
bertambah.
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Gambar 4.13 Tampilan T.evel 7

Pada level 7 jumlah mumi bertambah 1 menjadi 6, pemain harus menghindari kejaran 6
mumi tersebut,

Gambar 4.14 Tampilan Level 8

Pada level 8 jumlah treasure vang harus dikumpulkan untuk dapat menuju level berikutnya
makin bertambah tetapi jumlah mumi sama pada level 7.




Gambar 4.15 Tampilan Level 9

Pada level 9 jumlah mumi menjadi 7, stage ini menjadi level terakhir dalam game ini.
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4.2.5 Pengujian Petunjuk Permainan

Adapun menu lain pada Menu Utama adalah sebagai berikut.

I Peturjuk Permmingn SR ===

s

Sistemn permainan Tom Adventure, pemain akan
berperan sebagai Tom dan dapalt menggerakkannya
dengan tombol panah. Tugas pemain adalah
mengumpulkan semua berfian secara hati-hali agar fidak
menmyeniuh naga, dan lari menghindari kejaran mumi.

| Selalah semua berlian terkumpul, maka akan muncul
| tangga ke daerah lain dan pesmain harus menuju tangga
lersebul. Jika pemain lertangkap oleh mumi. atau
menyeniuh naga, maka life pemain akan dikurangi satu.
Pemain hanya diberi modal tiga life. Life hanya dapai
berlambah saat pemain menemukan putri yang muncul
jilka pemain mengambil semua bunga. Untuk
menyelesaikan permainan ini. pemain harus dapal
meangumpulkan semua berlian di samua dasrah.

Gambar 4.16 Tampilan Petunjuk Permainan

Option Petunjuk permainan berisi tentang bapaimana memainkan game Tom
Adventure, tombol Kembali berfungsi untuk kembali ke Menu Utama. Kemudian Option
Hi Score herisi tentang data skor tertinggi masing-masing pemain seperti yang ditunjukkan
gambar dibawah ini.




4.2.6 Pengujian Tampilun Hi Score

Hl SCORE
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4.2.7  Pengujian Tampilan Profil

Option Profil menampilkan tentang pembuat Game Tom Adventure ini.

Gambar 4,17 Tampilan Hi Score Tom Adventure
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Gambar 4.18 Tampilan Profil

49




Tabel Perbandingan Tom Adventure Lama Dengan Pengembangan

Tom Adventure

Tom Adveniure Lama

Pengembangan Tom Adventure

Permainan hanya mencapai level 5

Mumi tetap 3 dari level awal sampai
akhir

Tidak memiliki halaman start menu

Jumlah berlian tidak bertambah di

tiap level

Tidak memiliki tombol pause dan
stop

Tidak memiliki database

¢ Permainan ditambah 4 level sehingga

mencapai level 9

s Setiap 2 level mumi bertambah satu

* Ada halaman start menu yang memuat
petunjuk,seting pemain dan skor

tertinggl

# Jumlah berlian yang harus
dikumpulkan bertambah dan rintangan
naga juga bertambah.

e Tingkat permainan setiap levelnya
semakin sulit apabila level semakin

meaningkat

* Ada tombol pause dan stop

* Ada database untuk menyimpan skor
tertinggi
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BAB YV

PENUTUP

51 Kesimpulan
Setelah menyelesaikan perancangan perangkat lunak permainan Tom

Adventure, penulis menarik beberapa kesimpulan sebagai berikut :

I. Tingkat permainan setiap levelnya semakin sulit apabila level semakin meningkat.

2. Game lebih lengkap dari versi sebelumnys.

3. Dalam permainan ini telah ditambahkan karakier Mumi setiap 2 level dan
penambahan berlian di tiap level.

4. Rintangan Naga tiap level bertambah begitu juga flower.

52 Saran
Penulis ingin memberikan beberapa saran vang mungkin berguna untuk
pengembangan lebih lanjul pada perancangan perangkat lunak permainan Tom
Adventure, yaitu :
1. Perangkat lunak dapat dikembangkan menjadi multiplayer agar dapat dimainkan
vleh lebih dan | orang.
2, Pada pengembangan game selanjutnva diharapkan tampilan animasi vang sudah
berbasis 3D,
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4, Telah menempuh mata kuliah = 134 sks dengan IPK 2 2 dan tidak ada nilai E (.. 1. )
5, Telah mengikuu secara aktif keglatan seminar skripsi yang diadakan Jurusan (..., )
&, Memenuhi persyaratan administrasi (ocvdly)

Demikian permohonan ini untuk mendapatkan penyelesaian lebih lanjut dan -alas
serhatiannya kami ucapkan terima kasih.

Telah diteliti kebenaran data tersebut diatas Malarg, Bl o il il
Recorging Teknik Elektro : Pemohon
’ \
!
Jan
) (.0 MASSURl )
Disetuju bengetahui
Ketua Jurusandeknik Elekiro Dogen Wall

Catatan :

Bagi mahasiswa yvang ielah memenuhi persyvaratan mengambil SKRIPST agar membua

proposal dan mendapat persetujuan dari Ketua Jurusan/Sekretarnis lurusan T, Elekien 5-1
f?'f- Vi S

| Form. 5-1a




Instiul Teknolagi Masional Malang

'. Fakultas Teknologi Industr

hirusan Teknik Flekirp S«

LEMBAR PENGAJUAN JUDUL SKRIPSI
JURUSAN TEKNIK EL.EKTRO S-1 \

Konsentrasi ; Teknik Energi Listrik / Teknik Elektronika /Teknik Komputer &
Informatika /Teknik__Komputer ! Teknik Telekomunikasi*®)

Nama Mahasiswa: | ope MAISUO! | Nim- @&t f o4

Al I . o
2. | Wakiu Pengajuan )_Tanbgai. | Bulan; | Fahun;
Spesifikasi Judul (berilah tanda silang)**)

a. Sistem Tenaga Elektrik 2. Elektronika & Kemponen
7 3. Energi & Konversi Energi f.  Elektronika Digital & Komputer
" | v Tegangan Tinggl & g Elektronika Komunikasi

Pengukuran h. lainnva. ...

d. _Sistemn Kendali [ndustri _

Konsultasikan judul sesuai materi bidang ilmu Ketua Jurusin

kepada Dosen®)
4. :

AN Arprantr STMT

PexaoM BARCAY  (aHE il PUEH

o | Judul vang diajukan MENGEUNAr &N Mgl  Bapic
L ORMERUREWETT e e R B e .

I*erubahan judul vang
6. | disetujui Dosen sesual materi

bidang ilmu | e

Catatan:
" Disetwjui 1f 4 f ENTR
’ Dasen

| bidang ilmuo

Persctujuan Judul skripsi yang
dikonsultasikan kepada Desen materi

Perhatian:
1. Formulir pengajuan ini harap dikembalikan kepada jurusan pialing lambal satu
minggu setelah disetujui kelompok dosen keahlian dengan dilampirkan proposal
skripsi beserta persyaratan skripsi sesuai “orm S-1
2. Keterangan: *} Coret vang tidak perlu
) ditiagkari g, B ceniesiss atau g sesuai bidang keaklian




INSTITUT TEKNOLOGI NASTONAL
JL. Raya Karanglo,Km 2 MALANG

Lampiran : 1 (satu) berkas
Pembimbing Skripsi
Kepada . Yth. Bapak M. Ibrahim Ashari, ST MT

Dosen Institut Teknologi Nasional

Malang

Yang bertanda tangan di bawah ini;

MNama : Lolo Massudi
NIM ¢ 05.12.604
Jurusan : Teknik Elektro 8-1

Konsentrasi  : Teknik Komputer dan Informatika

Dengan ini mengajukan permohonan, kiranva Bapak bersedia menjadi
Dosen Pembimbing Utama untuk penyusunan Skripsi dengan judul
{proposal terlampir):

“ Pengembangan Game Tom Adventure Menggunakan Visual Basic
6.0%

Adapun tugas tersebut sebagai salah satu syarat untuk menempuh Ujian
Akhir Sarjana Teknik.

Demikian permohonan kami bual dan atas kescdiaaan Bapak kami
ucapkan terima kasih.

Mengetahui Malang , Juli2011

Ketua Jurusan Teknik Elektro 5-1 Hormat kami

Ir.Yusuf Ismail Nakhoda MT Lolo Massudi

Form 5-3a




INSTITUT TEKNOLOGI NASIONAL

JL. Raya KarangloKm 2 MALANG

Lampiran : 1 (satu) berkas
Pembimbing Skripsi
Kepada : Yth. Tbu Sandy Natali Mantja,5.KOM

Dosen Institut Teknologi Nasional

Malang

Yang bertanda tangan di bawah ini:

MNama : Lolo Massudi
NIM : 05.12.604
Jurusan : Tekruk Elektro S-1

Konsenmasi  : Teknik Kompuier dan Intformatika

Dengan ini mengajukan permohonan, kiranya Ibu bersedia menjadi
Dusen Pembimbing Pendamping untuk penyusunan Skripsi dengan judul
{proposal terlampir):

“ Pengembangan Game Tom Adventure Menggunakan Visual Basic

6.0 *
Adapun tugas tersebut sebagai salah satu syarat untuk menempuh Ujian
Alchir Sarjana Teknik.
Demikian permohonan kami buat dan atas kesediaazn Ibu kami ucapkan
terima kasih.
Mengetahui Malang , Juli 2011
Ketua Jurusan Teknik Elekiro 5-1 Hormat kami

Ir.Y usuf lsmail Laolo Massud:

NIP, Y. 101.880.018%

Form S-3a




INSTITUT TEKNOLOGI NASIONAL

JL. Raya Karanglo,Km 2 MALANG

PERNYATAAN KESEDIAAN DALAM PEMBIMBINGAN SKRIPSI

Sesuai permohonan dari mahasiswaii:

Mama : Lolo Massudi
MM - 05.12.604
Jurusan : Teknik Elekiro 5-1

Konsentrasi  : Tekmk Komputer dan Informatika

Dengan ini menyatakan bersedia/ tidakebersetlia*) Membimbing skripsi dari mahasiswa
tersebut, dengan judul:

“ Pengembangan Game Tom Adventure
Menggunakan Visual Basic 6.0 “

Demikian surat pernyataan ini kami buat agar dapat dipergunakan scperlunya.

Malang, Juli2011

Hormat kami

st

M. Ibrahim AshariST.MT
NIP ; Y. 1030100358

Catalan ;

Setelah disetuju agar formulir ini
Diserahkan mahasiswa/l yang bersangkutan
K.epada Jurusan untuk diproses lebih lanjut.

*) Coret yang tidak perlu

Form 5-3b




INSTITUT TEKNOLOGI NASIONAL

JL. Raya KarangloKm 2 MALANG

PERNYATAAN KESEDIAAN DALANV PEMBIMBINGAN SKRIPSI

Sesuai permohonan dari mahasiswa/i:

Nama : Lolo Massudi

NIM : 05.12.604

Jurusan : Teknik Elektro 5-1

Konsentrasi @ Teknik Komputer dan Informatika

Dengan ini menvatakan bersedia/ tidalk-bersedin®) Membimbing skripsi dari mahasiswa
tersebut, dengan judul:

“ Pengembangan Game Tom Adveninure
Menggunakan Visual Basic 6.0 ©

Demikian surat permyataan ini kami buat agar dapat dipergunakan seperlunya.

Malang, Juli2011

Sandy NatalyMantja S.KOM
NIP :P~.1030800418

Catatan :

Setelah disetujui agar formulir ini
Diserahkan mahasiswa/l vang bersangkutan
Kepada Jurusan untuk diproses lebih lanjur

*} Coret yang tidak perlu

Foorm 8-3h




Ingtitul Teknalogi Masional Matang
Fakultas Teknalogl Incdustd
Juruzan Teknlk Ebskbro 5-1

BERITA ACARA SEMINAR PROPOSAL SKRIPSI
JURUSAN TEKNIK ELEKTRO $-1

Konsentraal : Teknik Eneryl ListrikTeknik Elektronikal Teknik Komputer & Informatika®)

1. Nama Mahasiswa: | () .~ MASScIO] T INmoT(ifoH
5 | [Ketsrangan o Tanggal Waktu Tempat
" | Palaksanaan 19 ~gF ~Zgl Ruang:
Sgesifikasi Judul (berilah fanda siang}__!
a  Sistem Tenaga Eleldris ¢. Elekironika & Komponen
3, b Eneigi & Kenversi Energl f. Elektronika Digital & Kemputer
¢ Tegangar Tinggi & Pengukuran g. Elektronika Komunikasi
d. Sistern Kendali Indust h. lainnya ... :
TERL M RN AN, GANE, ToM., #E‘h’f’ﬁ:’.“.mf ......................
Jurdul Proposal Mengs Ull‘tm:_ nAgL o '
4. | yang dissminarkan ENSTNAEAY R T
Mahzsiswa
Ferubahan Judul yang
5 | diusulkan clen Kelompok
Cosan Keahllan
st e e
] Gatatar
" Porsetujuan Juddl Skips
Dlisatujul, | Liselujui, atuili,
Dosen Keahlian | Dosen Keahlian | ngen Keahlian 111
- |-~
" S U —— -"éy“ .ﬁﬂl'i'ﬁ‘___ | <’ AT T
L o Disstujul )
Mengetahui, ! S "
Retua durusan. ICE%GI] Dosen Pembimbing rI:-.
Permbimbjng Pembinibing !l
e oy
Perhatian,
1, Keterangan: ‘) Ceret yang lidak peru
") dilingkan &, b, c, ............ ..8tau g sesuai bidang keahlian

Form 5-3c




PERKUMPULAN PENGELOLA PENDIDIKAN UMUM DAN TEKNOLOGI NASIONAL MALANG
INSTITUT TEKNOLOGI NASIONAL MALANG

FAKULTAS TEKNOLOGI INDUSTRI
FAKULTAS TEKNIK SIPIL DAN PERENCANAAN
PROGRAM PASCASARJANA MAGISTER TEKNIK

T BNI|PERSERD]) MALAHG kampuz | I Bendungan Siguea-gura Mo, 2 Tep. (0341) 559431 (Hunting) Fa (2341) 553013 Matang 35143
BARIE HIAGH HALANE Wampus | = )N Raya Karanglo, Km 2 Tedp. {0341) 417836 Fay, [0341) 417634 Malang

e ————— ..  —————————/—————M—onr-tw——
Malang, 19 Juil 2011

Nomaor b TTN-3831.TA2M
Lampiran Do-
Perinal . BIMBINGAN SKRIPSI
Kepada . Yih. Sdr.fi. M IBRAHIM ASHARI, ST, MT
Dosen Institut Teknologi Nasional Malang
Dogen Pembimbing
Jurusan Teknik Elaktro S-1
di
Malang
Dengan hormat
Sesual dengan penmohonan dan persefujuan dalam Proposal Skrigsi
Untuk Mahasiswa
Nama : LOLO MASSUDI
Nim » 0512604
Fak=ltas ' Teknoog! Industr
Jurusan : Teknik Elekiro S-1

Konsentrasi  : Teknik KOMPUTER & INFORMATIKA

Maka dengan ini pambimbingan tersebut kami serahkan sepenuhnya
kepada Saudara/l selama masa waktu {enam ) 6 bulan, terhitung mulal
tanggal

09 Jull 2011 s/d 09 Januan 2012

Sebagal salu syarat untuk menempuh ujian Sarjana Teknik,
Jurusan Teknik Eleidro S-1

kasih

Tombugan Kepada Yth :
lﬁ_mw
A, Cored yang ek paviu




PERKUMPULAN RENGELOLA PENDIDIKAN UMUM DAN TEKNOLOGI NASIONAL MALANG
INSTITUT TEKNOLOGI NASIONAL MALANG

FARULTAS TEKNOLOGI INDUSTR
FAKULTAS TEKNIK SIPIL DAN PERENCAMAAN
FROGRAM PASCASARJANA MAGISTER TEKNIK

T EE,:L f:rl.élfrcl rir‘lmnﬁ -{'::!nfus- dl Eifndu-'ll_:[a.n E'ngL-m-g_ara H-:.nk Teip ((347) 551431 iHurﬂi[g] Fix. (0341) 553015 Malang G5143
Kemouz | Faya Keeanglo, Km 3 Tep 0341) 417836 Fax_ [0341) 417834 Malang

Malang, 18 Jufi 2011

Momer - ITH-3B4LTA2M1

Lampiran ;

Perihal . BIMBINGAN SKRIPS)

Kepada - Yih. Sdrfi. SANDY NATALY M, 5.XOM

Dosan Institut Teknologi Masional Matang

Ezern eibimbing
Junszan Tanik Bekim S-1

eli
Malang
Dengan homat
Sesual dengan permohonan dan persetujuan dalam Proposar Shiipsi
Untuk Mahasiswa
MNama 1 LOLO MASSLIDI
Nirm 1 0512604
Fakultas : Teknologi Industri
Jurusan : Teknik Elekino 5-1

Konsentrast  : Teknik KOMPUTER & INFORMATINA

Maka dengan ni pembimbingan tersebut kami serahkan sopenuhr' i3
kepada Saudarafi seiama masa waktu (enam ) 6 bulan, terhitung mulai
tanggal |

09 Jull 2011 s/d 09 Januart 2012

Sebagai satu syarat untuk menempuh ujian Sarjana Teknik,
Jurusan Teknik Eeklm S-1

Dernikian agar makium dan atas perhalias

rasih




INSTITUT TEKNOLOG] NASICNAL

JE. Bendungan Sigura-gors Mo, 2
MALANG

O

FORMULIR BIMBINGAN SKRIPSL

Nama :Lolo Massudi
NIM : 0512604
hMaseBimbingaen : D9Juli 2011 5/d 09 Januar 2002
JudulSkripsi : Pengembangan Game Tom Adveniure Menggunakan Visual Basic
6.0
i:m Tanggal Uraian PE:';::;HE
1 aff  haly T y
3 | Tws Gl 758
| o D
5 | a¢C G aly W | %/ |
. Qo bab V W
O e e |
7 o GabX ]
8 AL e ala ‘S-WW-“W?HQ«‘Q(J %
| 9 ! !
j
it J

Malang, 7 1o~ A0l

DosenPembimbing

Thod

M. Ihrahim Ashari STMT
NIP : P.10301 00358

Form 5-4b




INSTITUT TERNOLOGI NASIONAL

JI. Bendungan Sigum-gura No.2
MALANG

FORMULIR BIMBINGAN SKRIPSE

Mama :Lolo Massudi
NiM (0512604
MasaBimbingan  : 09Juli 2011 s/d 09 Januari 2012
IudulSkripsi : Pengembangan Game Tom Adventure Mengpunakan Visual Basic
6.0
NO Tnnggtli Uraian Pe:lfi':;hgi
[ I
Lp-o-i| 68 | £ 2 Dlesyis @ |
| L i ) :
| ! | . ) |
2 "é_ﬂ;._” Beae ( L2 Ok LAEYT PP 3 %?é |
4
| = |
30190y | 1ERERK AR W 7 TS |
T ¥
|
4 ;3{}?“' DEAS  Of— #_'
s | 20074 Moy ¥V o€ LadT MASAAL ,::éw ;
|
| _ |
6 | 20P-1l] QAN TAAT 6h  Vipr St HOS /‘f |
PV R S — 1 .'
7 \(3-00 1, povIGE (GpAren HAdl |
| . : |
B | g-ol opag PUTHE  camada/ |
9 |16 gp.1 Comr o MPpy % |
1 |
L | . |
Malang,

DosenPembimbing

Sandy Natalv Mantja. 5. KOM
NIP : P.1030800418

Form S-4b




i

R INSTITUT TEKNOLOGI NASIONAL
FAKULTAS TEKNOLOGI INDUSTRI
JURUSAN TEKNIK ELEKTRO 51 '
\
FORMULIR PENDAFTARAN UJIAN SKRIPSI

Namna | EALO MACUP|
NIM : Y {edai
Fakultas : | Telmologi Industri e
Jurusan/Konsentrasi : | T. Elektro S1/T. Elekuronika , T, Komputer& Informarika

Alamat di Malang s T Candy Sort WNo 22
Masa Penulisan Skripsi ;

Dosen Pembimbing H. fgotion bt L Koanly Manega | ©
Judul Skripsi Peucer Bugay care ToM ADOEN THIE
Mea'6e dnaiedty Vuae BASIC (O h
Persyaratan yang harus dipenuhi:
No Persyaratan Paraf*)
1 | Telah mengumpulkan 140 Sks dengan IPK ° 2
2 | Tidak ada nilai E
3 | Telah menyelesaikan/mengumpulkan Laporan Pracek Kerja i
4 | Telah menempuh semua praktikum yang di syaratkan Jurusan - J— i
5 | Menyerahkan Karm seminar !
g | Mengumpulkan foto copy buku Skripsi siap jilid yang telah
ditandantangani Dosen pembimbing rangkap 3 (Tiga) Eksemplar
|7 | Telah melunasi persyratan administrasi Rp. 150.000- .
Mengetahui, Malang égwm. 2010
Sekretaris Jurusan
T. Elekiro 1 Mahasiswa vbs
I
it
(Dr. Eng, Anvuanto Soetedjo, ST, MT) ( Loy SSCPt )
NIP, ¥. D30800417
L
Catatan:

*idiparaf Sekretars Jurusan
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